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TOPIC

DETAILS

Defaults for
Keyboard Increments

The “Units & Increments” preferences pane:
Size/Leading: Set the increments in points (.5).
Enlarge type:
Command Shift >
Reduce type:
Command Shift <
x5 times:
Option Command Shift < o >

Add the Shift key to increase
o decrease by ﬁve times
the default amount.

Baseline Shift: Set the increments in points (.5).

Shift up or down: Shift Option UpArrow o DownArrow

In the “Text” pane:
Small caps: Set in percentage of point size.
Apply small caps: Command Shift H
Super- and subscript: Set in percentage of point size and relative
position to baseline.
Superscript:
Command Shift +
Subscript:
Command Shift Option +
Toggle to remove super- or subscript
Leading

Because leading in InDesign does not have to apply to the entire
paragraph, you’ll ﬁnd it in the Charaer palette.
To add or decrease leading to selected text:

Add the Shift key to increase
o decrease by ﬁve times
the default amount.

Option DownArrow (add) o Option UpArrow (decrease)
(If you’re increasing the leading for an entire paragraph,
be sure to triple-click to select the entire paragraph!)

If you like, you can make the leading apply to the entire paragraph,
like it does in Quark. (The auto-leading value is in the Justiﬁcation dialog box, found in the Paragraph palette menu.)
Apply auto-leading to selected text: Command Option Shift A
Justiﬁed lines

You have a choice of four justiﬁed alignments:
With the last line justiﬁed on the left side.
With the last line centered.
With the last line aligned to the right.
With the last line stretched across the paragraph
to align it both left and right.
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Kerning and Tracking

Kerning applies when the insertion point is ﬂashing between

two charaers. The kerning value is actually applied to the
letter on the left.

Auto pair-kerns and Metrical kerning: This is the default.
Optical kerning: Use when a font has minimal pair kerns

or when mixing typefaces.
To see the exact value (shown in in parens), click between
two charaers after applying Optical kerning .

Manual kerning: Insertion point is between two charaers.
Add space:
Delete space:
x5 increment:

Option RightArrow
Option LeftArrow
Command Option RightArrow o LeftArrow

Tracking applies when more than one charaer is selected. Tracking

is added to the manual kerning (if any). Uses the same shortcuts
as above.

Remove all kerning and tracking from selected text:

Command Option Q

(Do not add the Shift key!!!!!)

Adobe Composer

InDesign uses one of these composition methods for all type.
Set the appropriate choice in your style sheets.
Paragraph Composer: Adjusts entire paragraphs of type to create
the best right edge with the smoothest rag. Works in conjunction
with all the other text settings. Use this setting when you have
paragraphs of type.
Single Line Composer: Gives you more control over where lines
break. Use this when you are setting several individual lines.

Single lines of type

Here are several tricks for single lines of text:
Flush left and right on ﬂexible line: Type the text you want to align
on the left; hit the Tab key; type the text you want on the right.
Now align right (Command Shift R). You can resize the line
length and the text will always line up on the left and the right.
(or insert a Right Indent tab; use the contextual menu.)
Justify on a ﬂexible line: Use the “Justify All Lines” option in the
Paragraph palette. Use a non-breaking space for word space:
Command Option X.
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Balance ragged lines

Use this feature to smooth the right edge even more, eecially
on headlines or short pieces of text. The Paragraph Composer
must also be chosen.

Distort text

Condense, stretch, squish: Select the charaers with the Text tool

and use the Charaer palette.

Rotate, shear: Select the text lock with the Pointer tool and use

the Transform palette.

Scale text

To make selected text larger or smaller: See page .

Text info

Use the Info palette (Window menu). This displays the charaer
count, word count, line count, and paragraph count for the story
in which the insertion point is ﬂashing.

Text frames

In the Text Frame Options dialog box, you can choose the number of
columns for a frame, the oﬀsets, alignment, and more. Open this
dialog box from the Object menu or press Command B.
To move or resize a text frame: Use the Pointer tool.
or if you are typing in the text frame, get the Pointer tool
temporarily by holding down the Command key—then you
can move or resize the frame without losing your Text tool.
When you resize a text frame, the text automatically adjusts its
margins and depth to ﬁt.

Scale a text frame
and the text in it

To scale a text frame and the text: With the Pointer tool, hold down

Paragraph spacing

Use the Paragraph palette. If the Space Before and Space After edit
boxes are not visile, use the palette menu to “Show Options.”

Drop caps

Create drop caps in a selected paragraph: Use the Paragraph palette.
In the left-hand Drop Cap ﬁeld, enter the number of lines

H

elp! I’m trapped
inside an enigma
and can’t get out!

Shift and Command when you resize a frame. The Charaer
palette will display the original point size and the scaled point size
in parentheses.

to drop.
In the right-hand Drop Cap ﬁeld, enter the number of letters
to drop.
To remove the drop caps: Select the paragraph and enter 0 (zero) in
the right-hand Drop Cap ﬁeld.

Glyph palette

Indiensale for use with OpenType fonts!

Story palette

Hang the punctuation with the click of a button! This applies to the

entire story and seriously slows down redraw and composition so
only use it when necessary. It’s in the Type menu.
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Eyedropper tool
to copy text attributes

Either select the text that has the attributes you want to copy, then

apply those attributes to other (unselected) text.
. Choose the Eyedropper tool.
2. Click on the text whose attributes you want to copy.
3. The tool changes to a full Eyedropper with an I-beam.
4. Drag over the text you want to apply the attributes to.
5. To deselect, click any other tool.

Or select text, then copy attributes of othe text to the selected text:

. Choose Text tool.
2. Select the text to which you want to apply attributes of
other text.
3. Choose the Eyedropper tool.
4. Click on the text from which you want to copy attributes.
5. The text you selected earlier now has the copied attributes.
6. The Eyedropper tool is still loaded with attributes so you
can drag over other text.
7. To deselect, click any other tool.

To pick up and apply only paragraph attributes: Keep the Shift key

down as you copy and apply attributes.

To change attributes in a loaded Eyedropper: Option-click on other

☞
White spaces

text.

To specify attributes to be loaded: Doule-click on the Eyedropper

tool in the Toolbar.

You can either use the keyboard shortcut, if there is one, or the
contextual menu.
Em space
Equal to the point size of the type
Command Shift m
En space
Equal to one-half the point size of the type
Command Shift n
Thin space
Equal to one-eighth the point size of the type
Command Option Shift m
Hair space
Equal to one-sixteenth the point size of the type
Command Option Shift I
Flush space
In justiﬁed text, this expands the last space to
force the last word or dingbat to the right edge
Figure space
Equal to a tabular (monospaced) number
Punctuation space Equal to a comma, period, or other small
punctuation
Non-breaking space Forces two words to stay together
Command Option x
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Special characters

Hyphen -

Create outlines

To change a single letter to outline, or a word, sentence, or
paragraph: Select the text with the Text tool. Go to the Type

Hyphen
En dash –
Option Hyphen
Em dash —
Option Shift Hyphen
Non-breaking hyphen Option Command Hyphen
Discretionary hyphen (it disappears when necessary; also use it in
front of a word to prevent hyphenation)
Command Shift Hyphen

menu and choose “Create Outlines.”

To change an entire text block to outlines: Select the frame with the

Pointer tool. Go to the Type menu and choose “Create Outlines.”
To manipulate the points: Use the white Direct Selection tool.

R

To add a drop shadow to type: You have to select the text frame with

Gradient tool

Select the text with the Text tool, then get the Gradient tool. Pressand-drag the tool over the text. It will use the default gradient.
If you select text with the Pointer tool, the Gradient tool will ﬁll the
text frame, not the text itself.

Drop shadows

the Pointer tool. Then add a drop shadow as you would
to a graphic (get “Drop Shadow” from the Object menu).
Experiment with text and a drop shadow on top of a photograph;
use the “Mode” menu in the dialog box.
Although you have to select the text with the Pointer tool to add
the shadow, you can then edit the text and the shadow will
redraw to match.

Robin

OpenType fonts

OpenType fonts are incredily wonderful. They can have up to

6,000 charaers in one font. Use the Glyph palette to access
and type with OpenType fonts.

Santa Fe mug
Santa Fe mug

Brioso Pro Regula
60 point
(too heavy)

Brioso Pro Display
60 point
(so lovely)
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Style sheets

InDesign has Paragraph Styles, Character Styles, and Nested Styles.
One cannot live without style sheets.
Paragaph styles apply to entire paragraphs. This is where you put
your ﬁrst-line indent for paragraphs or paragraph space after.
You can add drop caps, leading values, alignments, etc.
Character styles override paragraph styles and apply only to the
eciﬁc charaers you select.
Nested styles let you set up any number of charaer styles within a
paragraph style. The paragraphs below show a neﬆed style, where
the bold sans Myriad font appears until I type a colon, then it
switches to Brioso Pro.
Be careful with the “Based On” option—be sure that’s what you
really want because as soon as you change anything in the linked
style, it will apply to everything that is based on it. This can be
great, but can also wreak havoc if you apply “Based On” indiscriminately.
“Next Style” is fabulous. It only works as you are writing the text,
though—it will not automatically apply to any “next” text that
is already on the page.
To remove a style: Select the text and Option-click “No charaer/
paragraph style.”
To remove character formatting but preserve Character style sheets:

Option-click the name of the paragraph style.
To remove character formatting AND Character style sheets:

Shift-Option–click the name of the paragraph style.
Shortcuts for all styles: In the dialog box, click in the Shortcut ﬁeld.
Hold down any combination of the Shift, Command, or Option
keys, then press a number in the numeric keypad. Only the
numeric keypad works.
To import Paragraph and/or Character styles: Use the palette menu
to “Load Styles…” from another InDesign document.
Nested styles: First create the charaer styles you want to nest.
Then create a new style and choose the basic format of your paragraph for the main body copy.
Use the “Drop Caps and Neﬆed Styles” pane.
Click “New Neﬆed Style.”
In the “Neﬆed Styles” area, click on each option to get its menu,
then choose your options.
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Tabs and Indents

Oh my—this would be a two-hour class all by itself. Some tips:
Right-indent tab: Shift-Tab at the point in the line where you want it
to break. I’ll show you what I mean!
Indent to Here: Click in the line above the rest of the text you want
to indent. Control-click to get the pop-up menu, choose “Insert
Special Charaer,” then “Indent to Here.” Way cool. You can even
edit.
Repeat Tab: This a marvelous feature. It will repeat a tab across the
line the distance the selected tab is from the tab to its immediate
left or the margin.
Align On: In the Tab ruler, set a decimal tab and select it; type
a charaer in the “Align On” box. You can align on a colon,
question mark, number, or anything else you like.
Leaders can be customized: ^^ ^^ ^^ ^^ ^^ ^^ ^^ 56.
You can use up to eight charaers.
The Magnet button: This snaps the ruler to the margins of the story
that has the insertion point ﬂashing in it.

The row above is actually a text frame. I paﬆed the little face graphics into a line of text with a tab between each face, then
used the Repeat tab to space them evenly. I presed Command Option C to ﬁt the frame to the content. I colored the inside of
the frame saﬀron, hich makes it appea as if there are small boxes between the graphics. I gave the frame a thin lack stroke.
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